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ภาคผนวก ก
ขั้นตอนในการติดตั้งโปรแกรม LogMiner

ความต้องการทางด้านฮาร์ดแว?
ก่อนที่เราจะทำการติดตั้งโปรแกรม LogMiner เราควรจะตรวจสอบเครื่องคอมพิวเตอร์รอง 

เราให้พร้อมด้วย ส่วนประกอบทางด้านฮาร์ดแวร์มีดังต่อไปน้ี
1. เครื่องคอมพิวเตอร์รุ่น Pentium 100 ข้ึนไป
2. หน่วยความจำไม่ควรตํ่ากว่า 64 MB เป็นอย่างน้อย
3. Mouse และจอภาพ VGA หรือท่ีสูงกว่า
4. เนื้อที่ว่างไนฮาร์ดดิสก์ประมาณ 1 MB ข้ึนไป
5. ไดร์ฟซีดีรอมหรือฟล๊อปปีไดร์ฟสำหรับการติดตั้ง LogMiner
ส่วนประกอบของ LogMiner ต้องการระบบฮาร์ดแวร์ที่ค่อนข้างสูง ถ้าเรามีระบบฮาร์ดแวร์ 

ที่ไม่เหมาะสม เราอาจจะพบกับความล่าช้าบ้างในการใช้งานโปรแกรม เซ่น ความเร็วของซีพียูหรือ 
หน่วยความจำที่น้อยเกินไป เป็นด้น

ความต้องการทางด้านซอ?ฟแวร์
ส่วนประกอบทางด้านชอร์ฟแวร์มดีังต่อไปน้ี
1. ระบบปฎิบ้ติการ Window 98 หรือ Window Me หรือ NT
2. ระบบจัดการฐานข้อมูล MS SQL server เวอร์ซน 7.0
3. โปรแกรมติดต้ัง LogMiner



เนตอนุการติดตั้งโปรแกรม
เราเริ่มติดตั้งโปรแกรม LogMiner โดยการใส่แผ่นชีดีรอมลงในไดร์ฟซีดีรอมหรือใส่แผ่น

ฟลอปปีดิสก์ลงในฟล๊อปปีไดร์ฟ จากนั้นก๊อปปีไฟล์ทั้งหมดในไดร์ฟซีดีรอมหรือฟล๊อปปีไดร์ฟลงใน

1 ขยายไฟล์ LogMiner.zip โดยใช้โปรแกรม Winzip
2 ติดต้ังโปรแกรมระบบจัดการฐานข้อมูล Microsoft SQL Server Version 7.0
3 รันโปรแกรม SQL Server โดยใช้โปรแกรม SQL Server Service Manger
4 สร้างฐานข้อมูลซ่ือ log โดยใช้โปรแกรม Enterprise Manager
5 รันสคริปต์ภาษา sql จากไฟล์ db.sql ในโปรแกรม Query Analyzer โดยใช้ฐานข้อมูล 
log
6 ติดตัง System DSN ใน ODBC Data Source ทีอยู่ใน Control Panel โดยกำหนดให้ 
DSN name มีซ่ือว่า log_ โดยเลือกฐานข้อมูล log
7 ติดต้ังโปรแกรม Php coder ลงในเครื่องเว็บเซิร์ฟเวอร์
8 ก๊อปปี'ไฟล์ a.php และ uid.inc ลงในไดเร็คทอรื่ท่ีเก็บไฟล์เว็บเพจ
9 แทรกสคริปต์จากไฟล์ extended.html ลงในเว็บเพจทุกเพจในไซต์

เครื่องคอมพิวเตอร์ทีจะติดต้ัง ซึ่งขนตอนการติดตั้งมีตังนี๋
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คูมอการใช้งานโปรแกรม LogMiner

เมนูบาร์

- LogMiner
Eile Edit View Run Display Setting About Help

เมนูบาร์ (Menu Bar) ของ LogMiner มีลักษณะที่เราสามารถทำความเช้าใจกับเมนูต่างๆ 
ได้ไม่ยากเพราะมีลักษณะเหมือนกับเมนูของโปรแกรมทั้วๆไป รายละเอียดของเมนูแต่ละตัวมีดังนี้ 
เมนู File เป็นเมนูพื้นฐานที่สามารถพบได้ในเกือบทุกโปรแกรมใช้สำหรับเปิดล็อก

ไฟล์ข้ึนมาประมวลผล
เมนู Edit 
เมนู View

เมนู Run 
เมนู Display 
เมนู Setting

เมนู About

เมนู Help

เป็นเมนูที่ใช้ในการลบข้อมูลท้ังหมดในฐานข้อมูล
ใช้สำหรับแสดงหน้าต่างและเปลี่ยนมุมมองของหน้าต่าง เซ่น การแสดง
ทูลบาร์การแสดงลเตตัสบาร์
เป็นเมนูที่ใช้ในการรันโปรแกรม
เป็นเมนูที่ใช้สำหรับแสดงผลลัพธ์ต่างๆที่ได้จากการประมวลผล 
เป็นเมนูที่ใช้สำหร้บปร้บแต่งค่าพารามิเตอร์ต่างๆที่ใข้ในการประมวลผล 
เซ่น ค่าซัพพอร์ตข้ันตํ่า ค่าความเช่ือม่ันข้ันตำ ค่าช่วงเวลาระหว่างการ 
เย่ียมชมท่ีนานที่สุด ค่าช่วงเวลาระหว่างการเยี่ยมซมแบบทางผ่านที่นาน 
ท่ีสุด วันของผลลัพธ์ที่จะแสดงผล เป็นต้น
เป็นเมนูที่ใช้สำหรับแสดงรายละเอียดต่างๆของโปรแกรม เซ่น เวอร์ซน
ผู้พัฒนาโปรแกรม
ใช้สำหรบแสดงระบบช่วยแหลือ



เมนู File > Open เป็นเมนูที่ใช้สำหรับเปิดล็อกไฟล์ขึ้นมาประมวลผล



เมน File > Print เป็นเมนูที่ใช้สำหรับพิมพ์ผลล้พธ์ที่แสดงในหน้าต่างในชณะนั้น 
ออกทางเครึ่องพิมพ์

เมนู File > Print Preview เป็นเมนูที่ใช้สำหรับตรวจดูเอกสารก่อนพิมพ์



เมนู File > Print Setup เป็นเมนูที่ใช้สำห!บกำหนดค่าพารามิเตอร์ต่างๆที่ใช้ในการพิมพ์
เซ่น คุณสมบ้ตต่างๆของเครื่องพิมพ์ พิมพ์ในแนวต้ังหรือแนว 
นอน ขนาดกระดาษที่ใช้พิมพ์

เมน File > Exit เป็นเมนที่ใช้สำหร้บออกจากโปรแกรม



เมนู Edit > Clear เป็นเมนูที่ใชในการลบข้อมูลทังหมดในฐานข้อมูล



เม,y  D isp lay

Efe

เมนู Display > Stat 
เมนู Display > Log File

เมนู Display > Log DB

เป็นเมนูที่ใซ้สำหรับแสดงสถิติการเย่ียมซมต่างๆ
เป็นเมนูที่ใช้สำหรับแสดงบันทึกการเร้าซมหนึ่งวันที่ใซ้ในการ
ประมวลผลคร้ังล่าสุด
เป็นเมนูที่ใช้สำหรับแสดงบันทึกการเข้าซมท้ังหมดที่ยังไม่ถูก
ประมวลผล

เมนู Display > Association Rule เป็นเมนูที่ใช้สำหรับแสดงกฎความสัมพันธ์ 
เมนู Display > Sequential Pattern เป็นเมนูที่ใช้สำหรับแสดงรูปแบบสำดับ



เมนู Display > Stat
r-  - LoqMinftt____  pin £3£(* Y*» Bun finptay £ettr>g ôbout Help

>  r a  <T:M K g « B — P  IPS»*--------- ---------  LogFJ. URL SlatLogDB RefenorSlatAssociation Rufc Agent SlatSequential Pattern Paget/SessionSession Length 
V eka M a s  Vts*w/Oay

NUM

เมนู Display > Stat > IP Stat

|pjft _ Ë y - ■ พน:ริ̂ เ;-0.»pfaÿ.- g' -jfeout' fcjcfc) ^
e s s  ►  T

IE

IP Adrc» STAT 
12/8/2001

VISITOR a HU

1

202.183.22t.S7 161 3.49 230
203.150.2.234 147 3.18 147
203.107.184.252 69 1.49 69
158.10t. 5.8 58 1.26 175
203.150.1.201 41 0.89 41
161.200.2SS.1S3 39 0.84 97
168.120.63.35 37 0.80 81
203.101.128.62 33 0.71 130
202.44.10.80 27 058 160
202.57.151.253 25 0.54 156
203.98.2L42 25 0.54 54
203.144.223.73 24 052 65
20259.252.130 23 050 97
161.24652.23 22 0.48 42
202.28.27.50 21 0.45 140
63.251.169.235 21 0.4S 21
203.148.232.254 28 843 183 À

แสดงสถิติแยกตามค่าไอพีแอดเดรส (IP address) ซึ่งแสดงจำนวนผู้ซมแยกตามค่าไอพีแอด 
เดรส โดยแสดงจำนวนผ้ซมจริงและจำนวนเปอf เซนต์ฃองแต่ละไอพีแอดเดรส



เมนู D isp lay > S tat >  URL Stat

I III III! Mill I II— — ■ แ£to yiew Bun Cwplay Settro ôboU Help •
SS s  ►  B B » * I  *  ร t  ■ -

HHBI

HRL.SXAX
21/8/2001

URL visroft 54 HU
/jansie/duplayiovtr plnml 3308 71.63 7298
/ 640 13.86 704

121 2.62 123
f cp-bin/e ovatefc 0 n*o*r. p 1 109 2.36 149
/nm>ic/bpTK/ni4*x.j>terU 107 2.32 698
fremiti 102 2.21 125
/stat/ 98 2.12 113
famntfiyritJ 97 2.10 149
fmantfiynt 95 2.06 153
frxmit 91 1.97 118
/mnsif/nfwrtls&sï.phtml 90 1.95 96
/raoiie/r«qu«it/ 84 1.82 120
/name/r*qiM)t 78 1.69 111
/itM/3tat.plnœl 72 1.S6 372
fmovitf 66 1.43 82

54 1 17 187
/anmc/top?0 48 1.04 67

แสดงสถิติแยกตามเว็บเพจในไซด์(URL) ซึ่งเป็นสถิติที่แสดงจำนวนผู้ชมแยกตามเว็บเพจ โดย 
แสดงจำนวนคร้ังของการเยี่ยมชมทั้งหมดและจำนวนผู้ชมจริงที่เข้ามาดูเว็บเพจแต่ละเพจใน 
ไซด์

เมนู Display > Stat > Refenrer Stat

NUMReady



แสดงสถิติแยกตามแหล่งอ้างอิง (referrer) ซึ่งเป็นสถิต ิที่แสดงเกี่ยวกับแหล่งอ้างอิงต่างๆที่ช ่วย

นำผ ู้ซมเข ้ามายังไซต ์ เช่น จากเว็บไซต์อื่น, search eng ine, ไฟล์ในเครื่องผู้ซม, เว็บเพจอื่นไน

ไซต ์ และอื่นๆ โดยแสดงจำนวนผู้ชมจรง, จำนวนเปอร์เซนต์แยกตามแหล่งอ้างอิง

เม'y Display > stat > Agent Stat
AgerH Slat - LoqMirier w n pEfc E<* a<*> Dw** Ssttno èbox «<*► HO»*.-! Si."! Ÿ _____ . ' ■' "v - ; ■ โ:",' 'y

AGENT STAT
z z m r n

AGENT YisrroR Si anMoàllaM.O (•«9 ■ ร่น*; MSIE 5.0; Wmdowi 98; DigExt) 1260 27.28 3725
MosSjM.Q (ewnp «ร่น*; MSE 5.5, Windows 98, 9x 4.90) 502 18.87 1878
Moaül«/4.0 (<0*ร«ร่น«; MSIE 5.5; พฬ(ท» 98) 426 9.22 1262
Moàflntt.O (eomp «ร่น*; MSIE 5.01; Window Nr 5.0) 226 4.89 404
M«nfl*/4.0 («พ»?«ร่น*; MSIE 4.01; Window 98) 188 4.07 719
Moaûatt.01 («omyarfblO 181 3.92 181
PHP/4.0.4pll 147 3.18 147
MoâEi/3.0 (camp«ร่น*; AvudSo 3.2) 146 3.16 345
McaàHa/4.0 (comp«ร่น*; MSIE 5.01; Window 98) 98 2.12 268
MoxilW4.0 ("«ท?■ ร่น*; MSIE 6.0๖; Window 98) 73 1.58 174
Moaüa/4.0 (*0ท̂«ร่น*; MSIE 5.0; Window 98; DijF.t; Hotbar 2.0) 70 1.52 135
Mcaülntt.o («oŒpiàW*; MSIE 5.5; Windows 95) 68 1.47 269
MoâlUM.Q («ompaiM*; MSIE 5.0; Windows 95; DigExfl 46 1.00 227
Hojtfla/4.0 («oœpaàM*; MSIE 5.0; Windows NT; Dig&o) 45 0.97 207
Mosilla/4.Q (camp «ร่น*, MSIE 5.5; Windows NT 4.0) 45 0.97 122
r3d3 r2d2@swn«di«ft.eam 41 0.89 41
DowaloidD «ท 40 087 40su NUM

แสดงสถิติแยกตามโปรแกรมเว็บเบราเซอร์ (browser) ซึ่งเป็นสถิติที่ได้จากข้อมูลของระบบ 
ปฎิบติการและโปรแกรมเว็บเบราเซอร์แยกตามยี่ห้อและเวอร์ซนโดยแสดงจำนวนผู้ชมจรง 
และจำนวนเปอร์เซนต์แยกตามโปรแกรมเว็บเบราเซอร์



เมนู D isp lay > s ta t >  Pages/Session

P »  E<A Y'*w รนท fiitplaj» ร«ฬท51 0๖0J. Hefr
'เสั â  ►  ' D O MWl & ' ï

PAGE/SESSIQN STAT
22mmu

PAGE1 VISITOR40721S1
119

a88. Il 
3.27 
2.S8 
2.10 
1.06 
0.82 
0.48 
0.37 
0.26 
0.32 
0.09 
0.11 
0.11 
0.11 
0.06 
0.02 
0.02

R e e d y
J

;n u m ï  '

แสดงสถิติแยกตามจำนวนเว็บเพจที่เย่ียมชม (number of visited pages) ซ่ึงเป็นสถิติที'แสดง 
ว่าผู้ชมคลิกท่องไปในไซด์จำนวนกี่เว็บเพจในการมาเยือนแต่ละครั้ง ถ้าสถิติชี้ว่ามีผู้ซมจำนวน 
มากท่ีท่องเว็บเพจเพียงไม่กี่เพจ แสดงว่าการจัดระเบียบหรือการวางลิงก์ในไซด์อาจมีปัญหา 
หรือไม่เหมาะสม



— — — — — — ะ-เริฑn
Efc E<# Xm, Bun SMfcg è b o ï Heb

a  > B | M H  X, J-i' ร_____________________________________ ________________
REFKRNCTF. T.FNCrm STAT

2 2m m

เมนู D isp lay >  s ta t > SessionLength

LENGTH f sen VISITOR 54NULL 4618 100.00

R ead y NUM
Jj

แสดงสถิติแยกตามระยะเวลาที่ท่องในไซด์ (Time spent on site) ซ่ึง 
แสดงระยะเวลาที่ผู้ซมใช้ในการซมไซด์โดยแสดงจำนวนผู้ชมจริงแยก 
ตามระยะเวลาท่ีซม

เมนู Display > Stat > Visitor/Hour

Efe E Bm ĈPH* ร*ร êfccu tfeb 
เ ! 3  ►  B t l » H  t  1 Ï ร ร ิ "

HOUR

VBIOR/HOPR STAT
2 2 /พ พ

VISITOR 54 พ!2001-08-22 00:00:00.000 0 0.00 0
2001-08-22 81:00:00.000 0 0.00 0
2001-08-22 02:00:00.000 e 0.00 0
2001-08-22 03:00:80.000 0 0.00 0
2001-08-22 04:08:00.000 0 0.00 0
2001-08-22 05:00.-00.000 84 1.82 166
2001-08-22 06:00:00.000 120 2-73 227
2001-08-22 07:00:00.000 252 5.46 575
2001-08-22 08.-00:00.000 429 9.29 979
2001-08-22 0*08:00.000 607 13.14 1417
2001-08-22 10:00:00.000 731 15.98 1998
2001-08-22 11:00:00.080 863 18.69 2281
2001-08-22 12:08:00.000 932 20.18 2501
2001-08-22 13:08:00.000 871 18.86 2078
2001-08-22 14:00:00.600 38 0.82 46
2001-08-22 15:00:00.000 0 0.00 0
2001-08-22 14 0 0 00 000 0 0 00 0 ARsadv . 'ริริ:.;--J ''; - . NUM



แสดงสถิติแยกตามช่ัวโมงเข้าซม (visitors per hour) ซึ่งเป็นสถิติท่ีแสดงจำนวนผู้ซมแยกตาม
แต่ละช่ัวโมงของวัน โดยเริ่มต้ังแต่เวลา 00.00 -00.59 น. ไปจนถึง 23.00-23.59 น. โดยแสดง
จำนวนผู้ซมจริงและจำนวนเปอร์เซนต์ฃองแต่ละช่ัวโมง

เมนู Display > Stat > Visitor/Day
Visitor/day s»dt - LogMiner n n c i

£ k  E l* ï »  Buv frs ti»  SetaQ ôboน  B*> .
๕ a  ►  B O « « i  *  ร ?

แสดงสถิติแยกตามวันเข้าชม (visitor) ซึ่งเป็นสถิติที่แสดงจำนวนครั้งที่เข้าซมไชต์และจำนวนผู้ 
ซมจริงในแต่ละวัน



เ ม น ู D i s p l a y  > L o g  D B

B W S l ï d ld b js e  - LogMiner B E 1 E
0 »  £<* B ld  Ewfe* S ttiT Q  è b o u .....
■ ๕ 3 ►  a  I I  M M  J  . i  : î

L O G  D » f c » b o t -

2 2 / 8 / 2 0 0 1

Jfl 
1

IE
195.93.34.184

ทME
2001-08-22 05:02:29.000

บ RL
/movi*/fl*tvt/ffl4or.phSBl

REFERRER
hap Jt■ พ. ibsohotlyn*. « MB/ids/td*yd*. cp

2 2 น . 3S.1U.42 2001-08-22 05:02:58.000 /v'do/nrswrtlaaji/nritëO.shtml
3 195.93.34.184 2001-08-22 05:03:04.000 /mo'ท*/ทน■ พ!» P html hnp//wwwtUJD»m».eoin/rajjvi»/ii*Wni4oLph*nl
4 203.150.2.234 2001-08-22 05:03:23.000
5 203.151.87.17 2001-08-22 05:03:30.000 /mwic/dirpLiye ovtr.phtosl knp J/m ro. < aîcka. « O .th/tmm«/n8พ»น «J e .phtml
6 203.151.87.17 2001-08-22 05:03:30.000 /mua*/ displays trvtrphtmi hop jfw v rx . * «tek*. * O .ih/BBmc/anml* น « .phtml
7 283.151.87.17 2001-08-22 05:03:31.000 /musie/displaycovtr.pfaaHl hnp JfvKav. « ztfha. * O .th/mmüAuwr*l« a 1 • phtml
8 203.151.87.17 2001-08-22 05:03:31.000 iam àci dilp lryc phtml http'JAgCTw.etttha.CO■ tfa/i»mwc/n«,iar«lm» phtml
9 203.151.87.17 2001-08-22 05:03:33.000 /mini*/ display» ovtrphanl hap Jfvrant. « xttha. t O ,th/tmm*/*rs«r*l*ajt phtml
10 203.151.87.17 2001-08-22 05:03:33.000 fa a iùd  display* QV*f.phtml hnp Jhnrm . « «tcha. < O.tahnaà tht»  wrtli น « .phtml
11 203.151.87.17 2001-08-22 05:03:34.000 fcmiit/ display* ov«\phînsl http:/A»vrw.*itefaa-«o.th/nmsic/iu’»rel*aJi.phtnil
12 203. IS 1.87.17 2001-08-22 05:03:34.000 /music/display « overphaal hap ะ//พๆ »ไ». * Itch*. • O .ÛJam üthum nl*น t  .phtml
13 203.151.87.17 2001-08-22 05:03:36.000 hnaà fl dilplayt ov*r.phtml hap://tm»*r.ciîcha.eo.lb/nnjticAutsr«l**i».phanl
14 203.151.87.17 2001-08-22 05:03:37.000 /am tif/displays O’t'tf.pterai knp Jhmnr. « a«ku. c O ih/mnti«/n«T*r*l* ai « .phtml
15
16

203.1S1.87.17 
203 IS 1 87.17

2001-08-22 05:03:38.000 
2001-08-22 05:03 38 000

/man*/display* ov t t  .phtml hap J/wmr. c atcha. e 0 .di/nroüc/jirwrtl* «M.phtml

Z T *  J«1
R e e d y J ' » O. -  ! N tJM

เมื่อเลือกเมนู Log DB หน้าต่างจะแสดงแสดงบันทึกการเข้าชมทั้งหมดที่ยังไม่ถูกประมวลผลโดย 
หน้าต่างจะแสดง ค่ารหัสลำดับ ไอพีแอดเดรส เวลาเยี่ยมชม URL แหล่งอ้างอิง 
เบราเซอร์ท่ี'ใช้ รหัสประจำตัวผู้ซม

เมนู Display > Log File
£*> พ ุ ï *  ร ; : พ » ;■ ๕é  0*Th

Sottng ô b ô *  ■ รุเบัr ' : -

LOG -

2 2 / 8 / 2 0 0 1

1Q
1

JE
195.93.34.184

TIME
2001-08-22 05:02:29.000

URL
/m<ràfe/fl*'an/ffl4*xphtml

REFERRER
h a p //v tn r  ibsohw*lyn* «om/ids/idcy* น «P

2 2 น  JS . 116.42 2001-08-22 05:02:56.800 /vdo/ttawrcl* U e/nrO 2 0. thanl
3 195.93 J 4 .184 2001-08-22 05:03:04.000 /moüü/movit .phtml hap/y*m»w.ii*maon*.e<aB/müwA*«wiÆnd«x.phtml £ §
4 203.150.2.234 2001-08-22 05:03:23.000 /mssii«/nrs»r*l«aj «/ แ ร ฺ

hap ://*rww.c«t*hl_to.th/nmsi*/n*«r*lt*s*.phtml5 203.151.87.17 2001-08-22 05:03:30.000 kmMi*/ disp lay* m p h tm l
6 203.151.87.17 2001-08-22 05:03:30.000 fasosid display* ovtr.phanl kttp//wsTO. tacha, eo.th/ttmàs/ntwrtlt ait.phtml -ÿi:
7 203.151.87.17 2001-08-22 85:83:3 L080 /musi*/dùpJay«crt»tf.ph6Bl hnpJ/wwor.cït«hi«o.ih/Hmsi*/n*wnkaj».phanl ~§£
1 203-1S 1.87.17 2001-08-22 05:03:3 L000 /mrsàc/displayc O vttphtm l h y j)m m :ia d M .M .tf e a i iA w n l« M .p lt t r i  -j-v;
9 203.151.87.17 2001-08-22 05:03:33.000 /mrnic/display» ovtr.phaal hnp://'wori».«it*ha.*o.tii/ttmsi*/«*w*l**it.phtml :S~
10 203.15L87.17 2001-08-22 05:03:33.000 /mus»*/ display* ov*r.phtml hnpJ/ws»w.e*î*fai_co.Th/nioùc/n*'wr«l»iu*.phtml บ ั
11 203.151.87.17 2001-08-22 05:03:34.000 /music/display c 0จพ phtml http J/s6tww.e*tcÎ3a.*o.th/mDiic/nrs5r*lt»50.phtml vçrj
12 203.151.87.17 2001-08-22 05:03:34.000 /name/ dbplay* ovtf.pkBnl kttp://wwvr.**t*}i».*0.lhhrnssi»/nrs»r*l«*3».phîml ■ รุj|>
13 203.151.87.17 2001-08-22 03:03:36.000 /mnsù/displayc ers?», phtml hap:/hr»w.c*tt}ia.eo.th/mmif/&*t*rel*ast.phîml
14 203.1S 1.87.17 2001-08-22 05:03:37.000 /masse/display» v rtx . phtml kap:/fcrsm*.«<t*hA.««.th/amai*/ararcltut.phiml
15 203.151.87.17 2001-08-22 05:03:38.800 Amnie/display* ovïr.phsss! hapJ/***n».*it«luL«o.th/BUui*/n*w*l*u*.phtml รรรฺรุ่
น 203.151.87.17 2001-08-22 05:03:38.000 /muttc/duplaytovtrphtml htjp Jhrmm. cocha. t  O . th/mosi*ÀM’»r*U เร « .phtml iv-j
«L 1

R e o d y ■ r~  NUM f



เมื่อเลือกเมนู Log File หน้าต่างจะแสดงบันทึกการเข้าซมหนึ่งวันที่ใช ้ในการประมวลผลครั้งล่าสุด

โดยหน้าต่างจะแสดง ค่ารหัสลำดับ ไอพีแอดเดรส เวลาเยี่ยมซม URL แหล่งอ้างอิง

เบราเซอร์ที่ใช้ รหัสประจำตัวผู้ซม

เมนู Display > Association Rule
J- Association Rule - LogMinei B FinP» El* Vio, a>*> รฬ» Sdfas êtai b<*
:GÎ<S:  ̂ *oW«i * ร

AîTOciltto» R»l* -
22/8/2001

RULE 5UPPpftim) CPK̂PSKTre/ hrmùxilyricj.......... a- famùcjiyric 1.34 100.00 f§
/ hnoùifnqp* rtf--------> fomiicht que n 1.19 100.00
f tmasi* --------> foamei 1.49 98.57
/ AmmWrtqmrt --------> fomixthtqviiij 1.19 98.21
! fosamJ--------> fournie 1.49 97.18
1 fomüdiyàt --------> fmaûeftyàtJ 1.34 96.88
tamuAyà* fenntÆyri«AnA«cpkïml--------> fmaiitfiynd 1.17 94.74 :
/munt/r*<pj*tt --------» /nmsi ฝr*qu* ฟ 1.54 91.03
haandiyàtS /muneyiytwAailoLplrtjal --------> fomiidijue 1.17 88.52 II
พท่* fomud > f 1.49 88.46
fourni --------> fomàtJ 1.69 85.71
fomàckt qo* ฟ --------> AmuicA» qot !t 1.54 84.52
AnmieATïü tan«w/Fftw/ --------> / 1.34 8L58 n
Amiuc/lyiix --------> hxsnsiefiyiïcj 1.65 80.00
fmovid --------*■ / 1.13 78.79
Amuü/lyntf--------> /aroiieflyii» 1.65 78.35

1 r 1_1 jJReady O- ■ NÜM •

เมื่อเลือกเมนู Association ณ๒ หน้าต่างจะแสดงกฎความสัมพันธ์ที่ได้จากการประมวลผล ซ่ึง 
ประกอบไปด้วย กฎความสัมพันธ์ ค่าซัพพอร์ตคิดเป็นเปอร์เชนต์ และค่าความเชื่อมื่นคิดเป็นเปอร์ 
เซนต์



เมนู Display > Sequential Pattern
«เพ!-p•รน*»m  - i  — -

Ete £dt fl,E5S ► เ&พเ* ร«รท0 êbcui H«p■ # K f-i
S k q t m i l i a )  P u t t e r »  

22/8/2001
SEQUENCEร /rsnac--------> /malic/
/  /m atitJztqruTt — — > /anjùs/rttpwsît 
/ tmaixcfifàe —— —— -> /muîw/lyà «/
/anuü/ceqa*it •—  -----> /œmjc/r»<io«rt/
/«susic ------------- >  /am sic/
/munf/lync ------- > /œoïi«/hfiiฝ'
/snx/--------> /9grbtn/eoTHn«/»crimttf .pl
/tnzme/tyà* /snsiseüÿssฝ' —---femssio/lyrio/wultac.pliteii
ksoxxJ fy à s f------------- >  /orna ๘}?๐ t/tad«x.pîitml
/œuaie/lyn* ------- > /nmji«/lyEio/ind4x.p}jînil
/moji«/lyii« ------------- >  tenjàa/lync/ /m»ti«/}7 tie/mdtx.pliîinl

SUEEfflBIQM COMFJBErgffl0.01 099
0.01 096
0.01 0.92
0.01 0.88
0.02 0.85
0.02 0.77
0.02 0.73
0.01 0.68
0.01 0.61
0.01 0.59
0.01 0.53

เมื่อเลือกเมนู Sequential Pattern หน้าต่างจะแสดงรูปแบบลำดับที,ได้จากการประมวลผล ซ่ึง 
ประกอบไปด้วย รูปแบบลำดับ ค่าซัพพอร์ตคิดเป็นฟอร์เซนต์ และค่าความเชื่อมื่นคิดเป็นเปอร์

«ร'เซนต่



เมนู Setting

£k> £<* }£*» Bu* Setfng ôbout
โร &  ►  E3 s . j * M £ateInput ► »Modjie ►nrf&fiterSMtmfcmaoi*navfcmeoutrcn supportœinccrtdert _1

บ-ป
tsfUM :

เมนู Setting > Date เป็นเมนูที่ใช้สำหรับกำหนดวันที่ของผลลัพธ์จะทำการแสดงผล

ไดอะลอกสำหรับกำหนดค่าวันที่

รับค่าวัน เดือนปีเป็นต้วเลขจำนวนเต็ม 3 ค่า โดยค่าวันที่กำหนดจะถูกนำไปใช้ค้นหาข้อมูลเพี่อ
แสดงผล



เมนู Setting > Input เป็นเมนูที่ใข้สำหร้บกำหนดประเภทของข้อมูลเข้าว่าเป็นล็อกที่บันทึกอยู่
ในฐานข้อมูล (Log DB) ซื่งได้จากสคริปต์ที่ฝังอยู่ในเว็บเพจ หริอล็อก 
ไฟล์จากภายนอก (Log File)

เมนู Setting > Module เป็นเมนูที่ใข้สำหรับกำหนดโมดูลที่จะใข้ในขั้นตอนการกำหนด
ทรานแชคซันว่าจะนำการเยี่ยมซมแบบทางผ่านไปประมวลผลหรือไม, คือ 
ถ้าเสือก Session Timeout จะพิจารณาบันทึกการเข้าซมทั้งหมดไม่ว่า 
เป็บแบบทางผ่าน หรือแบบดูเน้ือหา แต่ถ้าเสือก Reference Length จะ 
พิจารณาเฉพาะการเยี่ยมชมแบบดูเนื้อหาเพียงอย่างเดียวเท่านั้น

fie  & s Bun ûsçfcÿ J £๙รทร è tn i  < Help 'V ‘ i  "-ะ'- ะ''; ะ e—i" ' น
๕  3  ►  B ; 3 m «  Bate---------- ------ 1.  u  f  :1 ■

Session Timeout : I -
*๙6'» « Reference length J

. . îessicofarrecwt 
ท3vtmeout
rain support
ffan corfefert _

•iL J



ไดอะลอกสำหรับกำหนดนามสกุลของไฟล์ในล์อกที่จะไม่นำมาพิจารณา

เมนู Setting > suffix filter เป็นเมนูที่ใช้สำหรับกำหนดนามสกุลของไฟล์ในบันทึก
การเข้าซมที่จะไม่นำไปประมวลผล ไนกรณีที่กำหนดข้อมูลเข้า
เป็นแบบ Log file

แสดงนามสกุลของไฟล์ในล็อกที่จะไม1นำมาพิจารณาในการประมวลผล 
ปม Add เป็นปมสำหรับแสดงไดอะลอกสำหรับเพื่มนามสกุลใหม่ของไฟล์ที่จะไม่นำมา

พิจารณา
ปม Delete เป็นปมสำหรับลบนามสกุลที่ถูกเลือกออกจากไดอะลอก 
ปม Default เป็นปุมสำหรับเปลี่ยนค่านามสกุลทั้งหมดที่แสดงให้เป็นค่าตั้งต้นที่กำหนดไว้ 
ปม OK เป็นปมสำหรับบันทึกนามสกุลทั้งหมดที่แสดงในไดอะลอกลงในไฟล์เพื่อนำไปใช้

ประมวลผลต่อไป
ปุม Cancel เป็นปมสำหรับปิดไดอะลอกโดยไม่มีการบันทึกค่าใดๆ 

ไดอะลอกสำหรับเพื่มนามสกุลของไฟล์ในล็อกที่จะไม่นำมาพิจารณา



เ ม น ู S e t t in g  >  s e s s io n  t i m e o u t  เ ป ็น เ ม น ูท ี่ใ ช ้ส ำ ห ร ับ ก ำ ห น ด ช ่ว ง เ ว ล า ร ะ ห ว ่า ง ก า ร เ ย ี่ย ม ซ ม ท ี่น า น  

ท ีส ุด

ไ ด อ ะ ล อ ก ส ำ ห ร ับ ก ำ ห น ด ค ่า ช ่ว ง เ ว ล า ร ะ ห ว ่า ง ก า ร เ ย ี่ย ม ซ ม ท ี,น า น ท ี่ส ุด

ปม OK เป็นปมสำหรับเพิ่มนามสกุลใหม่ที่รับเข้ามาไปแสดงในไดอะลอกสำหรับแสดงนาม
สกุลของไฟล์

ปม Cancel เป็นปมสำหรับยกเลิกการเพ่ิมนามสกุลใหม่

ร ับ ค ่า ช ่ว ง เ ว ล า เ ป ็น ต ัว เ ล ข จ ำ น ว น เ ต ็ม  ซ ึ่ง ม ีค ่า อ ย ู่ร ะ ห ว ่า ง  0  ถ ึง  5 9  โ ด ย ค ่า ท ี่ก ำ ห น ด จ ะ ม ีห น ่ว ย เ ป ็น  

น า ท ี ซ ึ่ง จ ะ ถ ูก น ำ ไ ป ใ ช ้ใ น ก า ร พ ิจ า ร ณ า แ บ ่ง แ ย ก ท ร า น แ ซ ค ช ัน ข อ ง ผ ู้ซ ม

เ ม น ู S e t t i n g  >  n a v  t i m e o u t  เ ป ็น เ ม น ูท ี่ใ ช ้ส ำ ห ร ับ ก ำ ห น ด ช ่ว ง เ ว ล า ร ะ ห ว ่า ง ก า ร เ ย ี่ย ม ซ ม แ บ บ

ท า ง ผ ่า น ท ี่น า น ท ี่ส ุด

ไดอะลอกลำหร ับกำหนดค ่าช ่วงเวลาระหว ่างการเย ี่ยมซมแบบทางผ ่านท ี่น านท ี่ส ุด

ร ับค ่าช ่วงเวลาเป ็นต ัวเลขจำนวนเต ็ม  ซ ึ่งม ีค ่าอย ู่ระหว ่าง 0 ถ ึง 59  โดยค ่าท ี่ก ำหนดจะม ีหน ่วย เป ็น  

นาท ี ซ ึ่งจะถ ูกนำไปใช ้ในการจำแนกข ้อม ูลการเย ี่ยมชมว ่าเป ็นการเย ี่ยมซมใช ้เป ็นแบบทางผ ่าน  (ถ ้า 

ม ีค ่าไม ่เก ินค ่าท ี่กำหนด)หร ือ เป ็นการเย ี่ยมซมแบบด ูเน ื้อหา (ถ ้าม ีค ่าไม ่ต ํ่ากว ่าค ่าท ี่ก ำห นด )

เมนู S e ttin g  >  m in  s u p p o r t เป ็นเมน ูท ี่ใช ้สำหร ับกำหนดค ่าช ัพพอร ์ฃ ั้นต ํ่า



ไดอะลอกสำหรับกำหนดค่าซัพพอร์ตข้ันต่ํา

รับค่าชัพพอร์ตข้ันต่ําเป็นตัวเลขจำนวนเต็มซ่ึงมีค่าอยู่ระหว่าง 1 ถึง 100โดยค่าท่ีกำหนดจะเป็น 
เปอร์เซนต์ของจำนวนทรานแซคชันข้ันต่ําเม่ือเปรียบเทียบกับจำนวนทรานแซคซันการเย่ียมชมท้ัง 
หมด

เมนู Setting > min condifent เป็นเมนูท่ีใซ้สำหรับกำหนดค่าความเช่ือม่ันข้ันต่ํา

ไดอะลอกสำหรับกำหนดค่าความเช่ือม่ันข้ันต่ํา

รับค่าความเช่ือม่ันข้ันต่ําเป็นตัวเลขจำนวนเต็มซ่ึงมีค่าอยู่ระหว่าง 1 ถึง 100 โดยค่าท่ีกำหนดจะ 
เป็นเปอร์เชนต์ฃองจำนวนทรานแซคชันข้ันต่ําเม่ือเปรียบเทียบกับจำนวนทรานแชฺคชันการเย่ียมซม 
ท้ังหมด



หลบาร ์

. I e £  1 . 1 ะ T
~

พ. .. ■* A_1 i » 1f

Open Print Run Log DB Log File asso seq Clear Help

ท ูลบาร ์ของโปรแกรม L o g M in e r เป ็นท ูลบาร ์ท ี่ป ระกอบด ้วยคำส ั่งพ ื้นฐาน  เซ่น O p e n  P rin t Run  

C le a r เซ ่นเด ียวก ับท ูลบาร ์ของโปรแกรมท ั่วๆไป

ปม O pen  

ปม P rin t

ปม Run  

ปม Log  DB  

ปม Log  F ile

เป ็นป ่มท ี่ใช ้สำหร ับ เป ิดล ็อกไฟล ์ข ึ้นมาประมวลผล

เป ็นป ่มท ี่ใช ้สำหร ับพ ิมพ ์ผลล ัพธ ์ท ี่แสดงในหน ้าต ่างในขณ ะน ั้นออกทาง

เครองพ ิมพ ์

เป ็นป ่มท ี่ใช ้ในการร ันโปรแกรม

เป ็นป ุมท ี่ใช ้สำหร ับแสดงบ ันท ึกการเข ้าซมท ั้งหมดท ี่ย ังไม ่ถ ูกประมวลผล  

เป ็นป ุมท ี่ใช ้สำหร ับแสดงบ ันท ึกการเข ้าชมหน ึ่งว ันท ี่ใช ้ในการประมวลผล

คร ังล ่าส ุด

ปม A s s o c ia t io n  R u le  เป ็นป ่มท ี่ใช ้สำหร ับแสดงกฎความส ัมพ ันธ  ์

ปม S eq u e n tia l P a tte rn  เป ็นป ่มท ี่ใช ้สำหร ับแสดงร ูปแบบลำด ับ  

ปม C le a r เป ็นป ่มท ี่ใช ้ในการลบข ้อม ูลท ั้งหมดในฐานข ้อม ูล

ว ิธ ีการใช ้งาน

1 เร ียกโปรแกรม L o g M in e r ข ึ้นมาทำงาน

2 กำหนดค ่าพาราม ิเตอร ์ต ่างๆท ี่ใช ้ในการประมวลผลก ่อนโดยเล ือกท ีเมน ู S e ttin g  เซ่น ค ่าซ ัพพอร์ต  

ข ั้นต ํ่า ค ่าความเช ื่อม ั่นข ั้นต ํ่า  และค ่าระยะเวลาท ี่น านท ี่ส ุดระหว ่างการร ้องขอ เป ็นต ้น

3 ส ั่งให ้โปรแกรมเร ิ่มทำการประมวลผลโดยเล ือกท ี่เมน ูหร ือท ูลบาร ์ Run

4 หล ังจากท ี่โปรแกรมประมวลผลเสร ็จ เร ืยบร ้อยแล ้วจะปรากฏคำว ่า P ro ce ss  C o m p le te d  ตรง 

กลางหน ้าต ่างและข ้อม ูลออกต ่างๆ ท ี่ได ้จาการประมวลผล คือ สถ ิต ิการเย ียมซมต ่างๆ  กฎความ  

ส ัมพ ันธ ์ และร ูปแบบลำด ับท ี่ค ้นพบ จะถ ูกล ัด เก ็บลงในฐานข ้อม ูลซ ึ่ง เราสามารถเร ืยกฃ ึนมาด ูได ้



ประว ้ต ิผ ู้เฃ ืยน

นาย วิญณู ละอองสุวรรณ เกิดวันท่ี 26 กันยายน พ.ศ.2520 ท่ีกรุงเทพมหานคร สำเร็จ 
การสืกษาระดับปริญญาตริวิทยาศาลตรบัณฑิต สาขาวิชาวิทยาการคอมพิวเตอร์ ภาควิชา 
คณิตศาสตร์และวิทยาการคอมพิวเตอร์ คณะวิทยาศาสตร์ มหาวิทยาลัยเทคโนโลยีพระจอมเกล้า 
เจ้าคุณทหารลาดกระบัง ในปีการสืกษา 2541 และเข้าสืกษ'าต่อ'ใน’หลักสูตรวิทยาศาสตรมหา
บัณฑิต สาขาวิชาวิทยาศาสตร์คอมพิวเตอร์ ภาควิชาวิศวกรรมคอมพิวเตอร์ ท่ีจุฬาลงกรณ์ 
มหาวิทยาลัย เม่ือ พ.ศ.2542
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